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Introduction

This guide provides the information you need to install, configure and use Identity Bridge 
Version 1.3. 

Further instructions for specific tasks can be found in the Identity Bridge Studio help. 
Additionally, the release notes include information relating to this release of Identity Bridge.

This section includes:

 l About this guide

 l What is Identity Bridge

 l Glossary

About this guide
This guide has the following sections:

 l Installing Identity Bridge

 l Investigating the user interface

 l Setting up and running projects

 l Advanced options

What is Identity Bridge
Identity Bridge is an identity synchronization and provisioning solution. It seamlessly 
integrates data between heterogeneous business systems across your enterprise and 
beyond.

Identity Bridge is a platform-independent application with  two primary components: 

 l a graphical user interface, Identity Bridge Studio; and

 l a synchronization engine.

Identity Bridge Studio allows you to build and maintain projects. 

The synchronization engine can run independently to deploy projects as batch processes. A 
project can be scheduled through your operating system's task scheduler, such as Windows 
Scheduler or cron.
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Glossary
The following terms have special meaning in Identity Bridge.

Project 
An Identity Bridge project is an ordered collection of one or more synchronization tasks. 
Each project is defined in a separate XML configuration file. The Identity Bridge Engine is 
typically called to run an entire project, although it is possible to instruct it to run individual 
tasks. It is also possible to disable individual tasks within a project.

Resource 
A generic name used in Identity Bridge to represent data sources and targets. Many 
resources such as LDAP Directories and Databases can be both source and target and 
used in many projects. The Identity Bridge Studio interface allows users to define resources 
as part of the workspace (from where they can be propagated into multiple projects) or local 
to a specific project.

Task 
Synchronization tasks are the basic building blocks of Identity Bridge synchronization 
projects. Each task has a single source and target. The source and target can be of any 
combination of the ‘connector’ types supported by Identity Bridge.

Workspace 
The file system directory used for the creation and maintenance of synchronization projects. 
The workspace facilitates the propagation of common resources and scripts between 
projects by providing a shared palette.

Workspace Explorer 
The navigation pane on the left side of the work area that expands and collapses allowing 
you to locate the exact component you need.
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Installing Identity 

Bridge

This section includes the instructions for installing and configuring Identity Bridge Studio.

It includes:

 l System requirements

 l Installing Identity Bridge

 l Specifying the workspace

 l Installing a license key

 l Upgrading Identity Bridge

System requirements
Platform requirements

Identity Bridge is a platform independent Java application. The Java Runtime Environment 
(JRE) version 1.8 or greater must be installed on the machine on which you wish to run 
Identity Bridge. You can download and install the latest JRE for your platform from:

www.java.com/getjava/

Memory requirements

The Identity Bridge synchronization engine requires approximately 128MB of available 
memory and Identity Bridge Studio (IBS) requires around 512MB.

Disk space requirements

Identity Bridge requires approximately 80MB of disk space. Additional disk space is required 
for workspace and project files.

Internal dependencies

The Identity Bridge engine makes use of the following versions of these third party libraries:

 l Mozilla Rhino - 1.7.9: To provide JavaScripting functionality

 l JavaMail API - 1.6.0: To provide send mail functionality

 l JSON.simple - 1.1.1: To encode and decode JSON text
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Installing Identity Bridge

Installing Identity Bridge
The Identity Bridge distribution includes two platform specific installers for platforms that 
have been fully tested and are officially supported by ViewDS. A platform independent zip 
file is also provided for users who wish to use Identity Bridge on an unsupported platform. 

The platform-specific installers are:

 l Linux: identitybridge-1.3-linux.sh

 l Windows: identitybridge-1.3-windows.exe

Platform-specific  installation

To install Identity Bridge Studio on one of the supported platforms:

 1. Download the appropriate Identity Bridge Studio installer for your platform (listed 
above).

 2. Double-click on the installer and follow the on-screen prompts. The installer wizard 
installs the Identity Bridge Studio. 

 3. Identify a workspace location. This should be a location on your network that is 
accessible to anyone who will use Identity Bridge. Create the required directory if it does 
not already exist.

 4. If you plan to use JDBC Resources, copy the required JDBC drivers (*.jar files) to the 
/ib_data/lib directory in your workspace. 

The precise location of this directory will depend on your Java installation.

Platform-independent installation

Although ViewDS does not formally support platforms other than those listed above, 
Identity Bridge is known to run well on other platforms provided that the system 
requirements are satisfied.

To install the platform independent .zip file:

 1. Download identitybridge-1.3.zip and extract the contents to the required 
directory, <IBSroot>.

 2. Identify a workspace location. This should be a location on your network that is 
accessible to anyone who will use Identify Bridge. Create the required directory if it does 
not already exist.

 3. Navigate to <IBSroot>/bin and run the appropriate executable or shell script file for 
your platform.

 4. If you plan to use JDBC Resources, copy the required JDBC drivers (*.jar files) to the 
/ib_data/lib directory in your workspace. 
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Specifying the workspace
The first time you launch Identity Bridge Studio you are prompted for a workspace location. 
This workspace is where all your project files will be stored. Use the browse button to 
navigate to the required location or enter the full path. 

Installing a license key
Identity Bridge is licensed separately from other ViewDS products. To obtain an Identity 
Bridge license key you should contact ViewDS Support either online via our support desk 
viewds.zendesk.com or by email support@viewds.com.

You can install and run Identity Bridge without a license key however you will be unable to 
run synchronization tasks.

Identity Bridge Studio
To install the license key through Identity Bridge Studio:

NOTE: In a typical Windows installation you must launch Identity Bridge Studio as a 
user with Administrator privileges in order to install a license key.

 1. Select Tools > Options from the menu.

 2. Choose the Identity Bridge options and select the License tab.

 3. Paste your license key into the box and click OK.

Command prompt
To install the licence key from the command prompt:         

 1. Navigate to the <install dir>/identitybridge/config directory.

 2. Copy the provided license.xml file  to this location.

Upgrading Identity Bridge 
To upgrade from a previous version of Identity Bridge, you should complete the following 
steps:

Backup licence key

 1. Navigate to the <IBSroot>/identitybridge/config directory. By default 
<IBSroot> on Windows is C:\Program Files (x86)\identitybridge.

 2. Copy the license.xml file in that location to a temporary location.

Uninstall previous version of Identity Bridge

Use the Windows Uninstall or change a program feature to uninstall ViewDS Identity 
Bridge or use a comparable process to uninstall Identity Bridge on Linux.
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Install Identity Bridge 1.3

Follow the installation instructions to install Identity Bridge 1.3.

Reinstate license key

 1. Navigate to the <IBSroot>/identitybridge/config directory. By default 
<IBSroot> on Windows is C:\Program Files (x86)\identitybridge.

 2. Copy the license.xml file you saved previously to this location.

Alternatively, follow the license key instructions to install the license key via the Identity 
Bridge Studio interface.

NOTE: In a typical Windows installation, you must launch Identity Bridge Studio as a 
user with Administrator privileges in order to do this.

Upgrading from 1.0?

You must verify existing Identity Bridge 1.0 projects using Identity Bridge Studio.

The first time you launch Identity Bridge Studio 1.3, it will automatically load your previous 
Identity Bridge 1.0 Workspace and update the projects it contains to make them compatible 
with Identity Bridge 1.3.

NOTE: It will not be possible to run processes and tasks created using Identity Bridge 
1.0 from the command line using the Identity Bridge 1.3 engine until you have done 
this.

NOTE: If you elected to remove the directory containing your Identity Bridge user 
profile when you uninstalled Identity Bridge 1.0, then your previous Identity Bridge 
1.0 workspace will not be automatically loaded and you must browse to its location in 
Identity Bridge Studio in order for the projects it contains to be updated.

Upgrading from 1.1 or 1.2?

There is no requirement to verify existing Identity Bridge 1.1 or 1.2 projects before using 
them with Identity Bridge 1.3.
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Investigating the user 

interface 

The Identity Bridge Studio user interface comprises the following:

 l Menu bar

 l Toolbar

 l Quick search

 l Workspace Explorer

 l Main work area

Menu bar
The Identity Bridge Studio menu bar contains the following menus:

 l File:Provides access to file operations such as Select Workspace, New Project, Save All 
and Exit.

 l Edit: Provides access to commands for editing JavaScript files including Undo, Redo, 
Cut, Copy and Paste.

 l View: Allows you to toggle the display of the System Log and JavaScript features 
including the JavaScript source editor toolbar and line numbers.

 l Tools: Provides access to the Options menu for Identity Bridge Studio.

 l Window: Allows you to manage the display of windows in the Identity Bridge Studio 
interface.

 l Help: Provides access to the Identity Bridge Studio online help

Toolbar
These tools are available in the Identity Bridge Studio main toolbar.

NOTE: Tools are active only when they are relevant to the current context.

 l Select Workspace: Allows you to reset the Identity Bridge Studio workspace location.

 l New Project: Opens the New Project window.

 l Save All: Saves changes in all open tabs.

- 7 -



Investigating the user interface

 l Run Project: Invokes the Identity Bridge engine to run the selected project.

 l Run Task: Invokes the Identity Bridge engine to run the selected task.

 l Refresh: Refreshes the Identity Bridge Studio display by re-reading the configuration 
files in the workspace.

Quick search
A quick search box is in the top-right corner of the Identity Bridge Studio interface. 

Start typing in the search box to view matching registered actions and help topics. Click an 
action to invoke it or click a help topic to view it.

Workspace Explorer
The Workspace Explorer provides a hierarchical list view of the current workspace. It 
comprises three expandable sections:

 l Projects: Displays all of the projects defined in the current workspace. Each project can 
be expanded to list all project specific variables, functions, resources and tasks. Each 
task can be further expanded to display any task specific variables and processes it uses.

 l Functions: Displays all of the workspace-wide functions that have been defined. 
Workspace-wide functions can be used in multiple projects.

 l Resources: Displays all of the workspace-wide resources that have been defined. 
Workspace-wide resources can be used in multiple projects.

Double-click on an item in the Workspace Explorer to display and edit configuration details 
about that item. 

For example, double-click on a project to open it in a new project tab in the main work area, 
double-click on a function to open the workspace JavaScript file in the JavaScript editor in 
the main work area, and double-click on a resource to open the Resource Configuration 
dialog for that resource.

Right click on an item in the Workspace Explorer to display relevant commands in a context 
menu. 

For example, right-click on a project to display a context menu containing commands 
including Rename Project, Run Project, View Project Log and Delete.
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Main work area
Identity Bridge projects are displayed in the main work area on separate Project tabs. In 
addition, a Palette tab that contains workspace-wide functions and resources is also 
displayed. 

Each Project tab comprises three views:

 l Design View (default view)

 l List View

 l Properties

Design View
Design View is a graphical representation of the project. It allows you to build 
synchronization processes by identifying resources as either sources or targets and linking 
them together with tasks. Design View has two modes:

 l Move Mode: Use this mode to drag resources to and from the workspace Palette and 
move project resources around the project space.

 l Connect Mode: Use this mode to create new tasks by left clicking on the resource you 
want to use as the source and dragging the connector to the required target resource.

NOTE: You can drag the connector back to the source resource if you want the 
source and target to be the same.

Right click on an item or in empty space in the Design View to display relevant commands in 
a context menu.

List View
List View is a tabular representation of the tasks in the project, listed in order of execution.

Double-click on a task in the table to open it in a new Task tab in the main work area.

Left-click and drag tasks in the table to change the order in which they are displayed and 
executed.

Properties
Properties displays the current project properties and lists any project variables that have 
been defined.
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Setting up and running 

projects

Setting up a synchronization project involves the following basic steps, each of which is 
described in more detail below:

 l Create a project

 l Define resources

 l Create tasks

 l Specify source and target resource schemas

 l Running projects

Create a project
The first step in setting up a new synchronization project is to create a new project or make a 
copy of an existing project.

To create a new project:

 1. Select File > New Project from the menu.

 2. Provide a Name for your project in the text field.

 3. Optionally, provide a Description for your project in the text box.

 4. Click Save.

A new empty project is added to the Workspace Explorer under Projects.

NOTE: You can also add a new project directly from the Workspace Explorer. Right-
click Projects under WORKSPACE in the Workspace Explorer and select New 
Project from the context menu.  

Alternatively, to make a copy of an existing project:

 1. Right-click on the project you want to copy in the Workspace Explorer and select Copy 
from the context menu.

 2. Provide a name for the new project in the text field

 3. Click OK.
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Define resources
Resources are the data stores for your synchronization projects. Resource definitions 
include the type of data store and the parameters used to access it (location, username and 
password, and so on). 

Resources can be specific to a project, for example flat file input or output resources, or they 
can be reusable resources, like LDAP and SQL sources, which can be used across multiple 
projects and should be defined at the workspace level. 

To define a project specific resource:

 1. In the Workspace Explorer, double-click on the project to which you want to add the 
resource. The selected project is displayed in a tab in the main work area. By default the 
project is displayed in the Design View.

 2. Right-click in the empty project space and select New Resource in Project from the 
context menu. The New Resource Wizard is displayed.

 3. Provide a name for the data source in the Resource Name text field.

 4. Choose the type of the data source from list of supported Connector Plugins.

 5. Optionally, add a Description of the data source in the text box.

 6. Click Next.
 7. Provide the necessary connection parameters for the data source. These will vary 

based on the type of the resource you are defining. Full details are provided in the 
Identity Bridge Studio help.

 8. Optionally, use the Test Connection button to verify the connection parameters you 
have provided.

 9. Click Finish. 

The new resource is added to the Workspace Explorer under Resources in the project you 
selected. It is also displayed in the project Design View.

You can also access the New Resource Wizard directly from the Workspace Explorer:

 l Right-click Resources in the project you want to add the resource to and select New 
Resource in Project from the menu. 

Or, to define a workspace wide resource: 

 l From the Workspace Explorer,  under Workspace right-click Resources and then click 
New Resource in Workspace from the menu.
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Create tasks
Tasks are the basic building blocks of Identity Bridge synchronization projects. Each task 
links a source resource to a target resource. The source and target resources can be any of 
the resource types supported by Identity Bridge. You can create tasks in the Project tab 
Design View and using the Workspace Explorer.

To create a task in the Project tab Design View:

 1. In the Workspace Explorer, double-click on the project you want to add the task to. The 
selected project is displayed in a new tab in the main work area. By default the project is 
displayed in Design View with Move Mode active.

 2. Click Connect Mode to switch to connect mode.

 3. In the project space, click on the source resource and drag to the target resource. An 
arrow is drawn between the source and target resources, representing the new task.

 4. Double-click the task arrow. The task is displayed in a new Task tab in the main work 
area. The Task tab allows you to define task properties.

 5. Provide a Task Name that identifies what the task will do.

 6. In the Index box, specify a number corresponding to position in which the task will run in 
the project. Leave this field blank to generate the index automatically. 

 7. Optionally, provide a description of the task in the Description text box.

 8. Click Save All on the main Identity Bridge toolbar to save your changes.

NOTE: You can also add a new task to a project directly from the Workspace 
Explorer. Right-click Tasks in the project you want to add the task to, select New 
Task from the context menu, and then follow steps 5 to 8 above.

Alternatively, to make a copy of an existing task:             

 1. Right-click on the task you want to copy in the Design View and select Copy from the 
context menu.

 2. Provide a name for the new task in the text field

 3. Click OK.

Specify source and target resource schemas
To map data in the source data store to data in the target you must specify source and target 
schemas. To specify the source schema:

 1. On the Task tab toolbar, click Source. The resource properties for the source are 
displayed. The data on this tab will vary depending on the type of resource.

 2. Check the values on the General tab and add any additional information. For example, 
for an SQL resource, enter the table name.
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NOTE: Existing resource parameters can be overridden allowing you to, for 
example, provide alternate credentials for a particular task. Any overridden 
parameters are shown in italics on the General tab.

 3. Click the Schema tab. The schema properties for the source are displayed.

 4. Click Load Schema to read the schema for the source and populate dropdown lists in 
each row added to the schema table with the elements identified.

 5. Alternatively, click Load Template to run a query based on the filter provided on the 
Resource tab to retrieve the first ten entries from the source data store and populate 
rows in the schema table using the values returned.

 6. Or, click Add to manually define rows in the schema table.

NOTE: When you populate either the Name or Internal Reference column for a 
given attribute, the     other column is automatically populated with the same name 
by Identity Bridge Studio.

 7. For LDAP and LDIF sources only, provide a suitable DN Reference (used internally to 
hold the distinguished name of each entry) in the text box. If no value is provided the 
default value of dn will be used.

To specify the target: 

 1. On the Task tab toolbar, click Target. The resource properties for the target are 
displayed. The data on this tab will vary depending on the type of resource.

 2. Check the values on the General tab and add any necessary information.

NOTE: Existing resource parameters can be overridden allowing you to, for 
example, provide alternate credentials for a particular task. Any overridden 
parameters are shown in italics on the General tab.

 3. Click the Schema tab. The schema properties for the target are displayed.

 4. Define the target resource schema as described above for the source resource.
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Schema table format
The format of the schema table is described below.

Schema 
Field

Source Target Description

Name √ √ The name of the attribute/field in the source.

Internal 
Reference

√ √

The Identity Bridge  identifier for the attribute/field. This is the 
name given to the attribute/field in the internal record passed 
between the source and target and the one used by script 
processes.

Internal 
Type

√ √
The data type the attribute/field should be treated as for internal 
processing.

Key Field √ √
Identifies the attribute/field as a key field used to uniquely 
identify a record/entry. The key for a record can be made up of 
multiple fields.

Ignore 
Reading

√  

Indicates that the attribute/field should be ignored when reading 
records. This is only required for fixed length or csv/tab 
delimited sources without header lines, where it is necessary to 
specify every field in the schema.

Ignore 
Delta

√  
Indicates that the attribute/field should be excluded from those 
that are checked for changes when using the Delta function.

Ignore 
Writing

 √
Indicates that the attribute/field should be ignored when writing 
records

Running projects
Identity Bridge projects can be run from Identity Bridge Studio or the command line.

From Identity Bridge Studio
Identity Bridge Studio enables you to run entire projects or individual tasks directly from the 
toolbar.

To run a project:

 1. In the Workspace Explorer, double-click on the project you want to run.

 2. Click Run Project on the main Identity Bridge toolbar.

To run a task:

 1. In the Workspace Explorer, double-click on the task you want to run.

 2. Click Run Task on the main Identity Bridge toolbar.
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From the command line
The Identity Bridge synchronization engine can also be run independently to deploy projects 
as batch processes that can be scheduled by operating system specific task schedulers 
such as Windows Scheduler or cron.

To run a project from the command line:

 1. Navigate to the <install dir>/identitybridge/modules directory.                  

 2. Run the synchronization engine with the following command:               

'java -jar com-viewds-identitybridge-engine-runner.jar -

workspace <workspace directory path> -project <project name> [-

task <task name>]'

Where: 

<workspace directory path> is the workspace location

<project name> is the name of the project you wish to run and the optional 

<task name> is the name of the task within that project you wish to run

- 16 -



ViewDS Identity Bridge: Getting Started

Advanced options

In addition to the basic steps described in Setting up and running projects, you can add 
optional processing steps to your synchronization project.

 l Processes, functions and variables

 l Delta updates

 l Change logs

 l Support for Java classes and native libraries

This section also describes the following:

 l Supported resource types

 l Built-in functions

Processes, functions and variables
Processes are procedures that modify the source data for a given task before it is written to 
the target resource. They are constructed using variables and functions.

Although it is not necessary to use processes when synchronising data with Identity Bridge, 
doing so can add significant value to the synchronization process.

Variables
Variables can be created for individual tasks or whole projects. They are used by functions 
to  store data that may change as the task or project progresses.

The steps required to create a variable are the same regardless of the type of variable you 
are creating.

NOTE: Task-specific variables are initialised each time the task is started whereas 
project wide variables are initialized when the project starts. This means that project-
wide variables persist from one task to another, for example to maintain and pass a 
project error count.

To create a variable:

 1. Navigate to the required Project or Task tab in the main work area.

 2. Click Properties in the tab toolbar.
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 3. In the Task or Project Variables section, click Add. A new row is added to the variable 
table.

 4. Double-click the Variable Name cell in the new row and enter a variable name.

 5. Double-click the adjacent Value cell and enter an initial value for the variable. The 
following variable types are supported:             

 a. Simple string (e.g. v1 = ABC)

 b. Integer indexed array (e.g. v2 = ["top", "person", "organizationalPerson"] where v2
[0] = top , v2[1] = person, etc.)

 c. Associative array (e.g. v3 = {"num":100, "is_vip":true, "name":"Tom"} where v3
["num"] = 100, v3["name"] = Tom, etc.)

 d. Complex array (e.g. v4 = [ {"num":100, "is_vip":true, "name":"Tom"}  {"num":200, 
"is_vip":false, "name":"Jerry"} ] where v4[0]["num"] = 100, v4[1]["name"] = Jerry, 
etc.)

 6. Click Save All on the main Identity Bridge toolbar to save your changes.

NOTE: A variable is only available for use in a function after it has been saved.

Functions
Functions are used to perform data manipulation in Identity Bridge. These functions can be 
called in a number of different contexts and it is important to understand what values (if any) 
are passed to the function by the Identity Bridge Engine and what values are returned, in 
order that you use the correct syntax for the function. See JavaScript Functions Editor in the 
Identity Bridge in-application help for further details.

Define a function

To define a function:

 1. Navigate to the required Task tab in the main work area.

 2. Click Processes in the Task tab toolbar.

 3. Click Define Function(s). A JavaScript source editor opens in a new tab. If any 
functions have already been defined for the project, then they will be displayed here. 
Otherwise the source editor will be empty.

 4. Define your function using standard JavaScript. For example:                  

 function assignDn(rec)
    {

    // assign dn and objectClass for record. In this case dn_base 

variable is passed in as a task or project variable

    rec['dn'] = 'cn=' + rec['cn'] + dn_base;

    rec['objectClass'] = new Array( "top", "person", 
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"organizationalPerson" );

    return rec;

    }

 5. Click Save All on the main Identity Bridge toolbar to save your changes.

Once a function has been created, it can be used in any task-specific process in the project.

NOTE: Functions become available for use in processes only after they have been 
saved.

View built-in functions

Identity Bridge also includes a number of built-in functions.

To view a list of built-in functions:

 1. In the JavaScript source editor, type:                 

$context.

 2. Press the CTRL and SPACE keys together. A list of available functions is displayed.

 3. Double click on a function in the list to copy it to the JavaScript source editor.

NOTE: All functions for a given project are saved in the same *.js file.

Processes
There are four contexts in which functions can be called in a process:

 l Task Initialization: This function is called when the task is initialized (before any records 
are processed).

 l Task Termination: Called when the task is terminated (after all records are processed).

 l Audit at Target: Called on a per entry/record basis at the target for the purposes of 
providing audit information and (optionally) subsequent additional processing.

 l Per Entry/Record: These functions are called on a per entry/record basis. They can 
receive and return a single field/attribute or whole entries/records.

NOTE: The appropriate syntax for functions depends on the context in which they 
are called. See JavaScript Functions Editor in the Identity Bridge in-application help 
for further details.

To add an initialization, termination or audit function to a process:

 1. Navigate to the required Task tab in the main work area.

 2. Click Processes in the Task tab toolbar.

- 19 -



Advanced options

 3. Optionally, select the required initialization function from the Task Initialization 
Function drop-down list.

 4. Optionally, select the required termination function from the Task Termination 
Function drop-down list.

 5. Optionally, select the required audit function from the Audit Function at Target drop-
down list.

 6. Click Save All on the main Identity Bridge toolbar to save your changes.

NOTE: Initialization, termination and audit functions should not be added to the 
function table.

To add a per entry/record function to a process:

 1. Navigate to the required Task tab in the main work area.

 2. Click Processes in the Task tab toolbar.

 3. Click Add. A new row is added to the function table.

 4. Double-click the Function cell in the new row and select a function from the drop-down 
list.

 5. For functions that work only with a specific attribute/field, select the appropriate Field 
Reference from the drop-down list. The Field Reference column should be left empty 
for functions that receive and return whole records.

 6. Repeat steps 3 to 5 above to add multiple functions to the process.

 7. Left-click and drag functions in the table to change the order in which they are 
processed.

Delta updates
Identity Bridge provides a delta update feature that allows you to configure the 
synchronization process so that only records in the source that have been added or 
changed since last time are processed and passed to the target. Using this can improve the 
performance of synchronization processes and reduce the load on target systems.

The delta update feature can also be used to identify records that have been deleted from 
the source and delete, or otherwise process, the corresponding entries in the target.

NOTE: The delta update feature is also required in order to use the change log 
connectors supported by Identity Bridge. See the Change logs topic for further 
details.

Defining a delta database
In order to use the delta update functionality in Identity Bridge you must first define a delta 
database resource. Identity Bridge uses the delta database to store and manage a number 
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of data tables that keep track of changes to the source data.

To define a delta database resource:

 1. In the Workspace Explorer, right-click Resources under WORKSPACE and select 
New Resource in Workspace from the context menu. The New Resource Wizard is 
displayed.

 2. Provide a name for the delta database in the Resource Name box.

 3. Choose Delta Data Store from the Connector Plugins list.

 4. Optionally, add a Description of the delta database in the box.

 5. Click Next.
 6. Provide the JDBC URL of the delta database in the Database JDBC URL box, for 

example jdbc:h2:tcp://localhost/~/test.

 7. Provide the Java Classname of the JDBC Driver for the delta database in the JDBC 
Driver Class box, for example org.h2.Driver.

 8. Provide a valid username for the delta database in the User Name box.

 9. If required, provide the password for the user in the User Password box. Most SQL 
databases can be used as the Identity Bridge delta database, for example, MSSSQL, 
MYSQL, H2 and so on. However, the use of MS Access is not currently supported as it 
does not allow for suitably large key fields.

 10. Ensure that you have copied the appropriate JDBC driver for your chosen SQL 
database into the /ib_data/lib directory in your workspace (see Installing Identity 
Bridge for more details).

 11. Optionally, use the Test Connection button to verify the connection parameters you 
have provided.

 12. Click Finish.

 13. Click Save All on the main Identity Bridge toolbar to save your changes.

Adding a delta database to your project
To add a delta database to a project:

 1. In the Workspace Explorer, double-click on the project you want to add the delta 
database to. The selected project is displayed in a tab in the main work area in the 
Design View with a Palette containing previously defined Workspace Functions and 
Workspace Resources on the right.

 2. Ensure Move Mode is selected, then click and drag the delta database resource from 
the Palette to the Design View.

 3. Click Save All on the main Identity Bridge toolbar to save your changes.
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Adding the delta update feature to your 

synchronisation task
The delta update feature can be added to new or existing synchronisation tasks once a delta 
database resource has been added to the project.

To add the delta update feature to an existing synchronisation task:

 1. In the project Design View, double-click the arrow associated with the task you want to 
edit. Alternatively, in the Workspace Explorer, expand the Tasks node within the 
project and double-click on the task you want to edit. The Task tab is displayed.

 2. On the Task tab toolbar, click Delta. The delta update options for the task are displayed.

 3. Select Enable Delta Evaluation. This enables the delta evaluation task which 
identifies changes in the source by generating hash values for each record and 
comparing these to the hash values stored in the delta database. New records are also 
identified.

 4. Select the appropriate delta database from the Delta Store Resource dropdown list.

 5. Provide an identifier, to be used as a prefix for Identity Bridge tables in the delta 
database, using the Delta Table(s) Identifier box.

 6. Optionally, modify the Processing Step Index for the delta evaluation task. By default, 
this is set to 0, meaning that delta evaluation takes place before any other processes. In 
most cases this is appropriate. However, you may need to adjust the Processing Step 
Index if, for example, you want to transform the source data using a function prior to 
performing the delta evaluation.

 7. Provide the name of the attribute/field used to uniquely identify entries in the source for 
delta evaluation in the Source Key Reference box.

 8. Provide the name of the attribute/field used to uniquely identify entries in the target for 
delta evaluation in the Target Key Reference box. If more than one attribute or field is 
required to uniquely identify entries in the source and/or target, then you must create a 
composite attribute from those keys using a processing function.

 9. Optionally, check Enable Delta Confirmation. This enables the delta confirmation 
task which verifies that the changes identified by the delta evaluation task have been 
made in the target and updates the delta database accordingly. This task always takes 
place last.

 10. Provide the name of the attribute/field used to uniquely identify entries in the target for 
delta confirmation in the Target Key Reference box.

 11. Click Save All on the main Identity Bridge toolbar to save your changes.

Using the delta update feature to handle deletes
The most common reason for using the delta update feature, aside from improving 
performance, is to identify deleted records in the source and delete (or otherwise process)  
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the corresponding records in the target. To use the delta update feature for this purpose a 
separate ‘deletes’ task which uses the delta database as the source must be created.

To create the deletes task:

 1. In the Workspace Explorer, double-click on the project you want to add the deletes 
task to. The selected project is displayed in a new tab in the main work area. By default 
the project is displayed in Design View with Move Mode active.

 2. Click Connect Mode to switch to connect mode.

 3. In the project space, click on the delta database resource and drag to the target 
resource. An arrow is drawn between the delta database and target resources, 
representing the new deletes task.

 4. Double-click the task arrow. The task is displayed in a new Task tab in the main work 
area.

 5. Provide a Task Name that identifies what the task will do.

 6. In the Index box, specify a number corresponding to position in which the task will run in 
the project. Leave this field blank to generate the index automatically.

 7. Optionally, provide a description of the task in the Description text box.

 8. Click Save All on the main Identity Bridge toolbar to save your changes.

To configure the deletes task:

 1. On the Task tab toolbar, click Source. The resource properties for the delta database 
are displayed.

 2. Enter the Delta Table(s) Identifier, as specified previously, in the box.

 3. Check Fetch untouched delta entries from last run box. This compiles a list of 
records removed from the source since the last time the delta tables specified above 
were updated by identifying all delta entries for which the timestamp has not been 
updated.

 4. Click the Schema tab. The schema properties for the delta database are displayed.

 5. Click Load Template to populate rows in the schema table. The table is populated with 
two rows for SOURCE_KEY and TARGET_KEY.

 6. On the Task tab toolbar, click Target. The resource properties for the target are 
displayed. The data on this tab will vary depending on the type of target resource.

 7. Check the values on the Resource tab and ensure that the appropriate run mode for 
deletes is selected, for example DELETE_EXIST for to delete entries in an LDAP 
resource.

 8. Click the Schema tab. The schema properties for the target are displayed.

 9. Click Load Source Schema to copy the schema from the source schema definition.                 
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If the target resource is not LDAP or the key reference  is not the distinguished 
name, then you must map the TARGET_KEY internal reference to the 
corresponding key reference identifier in the target  and check the Key Field box.

 10. On the Task tab toolbar, click Delta. The delta update options for the deletes task are 
displayed.

 11. Check Enable Delta Confirmation.                

It is not necessary to Enable Delta Evaluation when configuring a deletes task 
since the evaluation task is inherent when using the delta database as the 
source.

 12. Provide the name of the attribute/field used to uniquely identify entries in the target for 
delta confirmation in the Target Key Reference box.

 13. Check Delete Delta entry on Confirmation. This will result deleted entries being 
removed from the delta database on successful completion of processing at the target.

 14. Click Save All on the main Identity Bridge toolbar to save your changes.

Change logs
Change logs can be generated by some types of resources. They record all the changes 
made to the source data and can be used to facilitate 'on change' updates with Identity 
Bridge. Change logs are particularly useful when you want to make frequent updates or if 
your dataset is particularly large, since only data that has changed is passed from the 
source to Identity Bridge.

Identity Bridge includes connectors for LDAP Changelog and Active Directory Change 
Detection. In both cases a total update task is also required (for initial synchronisation and in 
the event that the source and target become mismatched). In addition, a delta database is 
required in both cases to enable the correct mapping of entires in the source to entries in the 
target.

Overviews of the steps required to set up both connectors are provided in the sections 
below:

LDAP Changelog
 1. Create a total update task using the  LDAP connector for the LDAP source (see Define 

resources and  Create Tasks). Ensure that a delta database resource is defined and 
delta updates are configured for the total update task (see Delta updates).

 2. Create a change log update task using the LDAP Changelog connector for the 
LDAP source. Ensure that the appropriate run mode for your chosen target is selected, 
for example CHANGE_RECORD for an LDAP target resource. Also, ensure that  delta 
updates are configured for the change log update task.
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NOTE: It is not necessary to create a separate deletes task for the LDAP Changelog 
connector, as these are handled automatically.

Active Directory Change Detection
 1. Create a total update task using the Active Directory connector for the Active 

Directory source. Ensure that a delta database resource is defined and delta updates 
are configured for the total update task.

 2. Create a change log add and update task using the Active Directory Change 
Detectionconnector. Ensure that source Scope for the task is ADDED_OR _
UPDATED. Ensure that the appropriate run mode for your chosen target is selected, 
for example CHANGE_RECORD for an LDAP target resource. Ensure that delta 
updates are configured for the add and update task.

 3. Create a change log delete  task using the Active Directory Change Detection 
connector. Ensure that source Scope for the task is DELETED. Ensure that the 
appropriate run mode for your chosen target is selected, for example CHANGE_
RECORD for an LDAP target resource. Ensure that delta updates are configured and 
that Delete Delta Entries on Confirmation is checked for the Delta Confirmation 
task.

Support for Java classes and native libraries
It is possible to make use of Java classes (.jar files) and native libraries within Identity 
Bridge. To do this place the .jar files and libraries in the /ib_data/lib directory in your 
workspace.

Supported resource types
Generic LDAP 

Active Directory Change Detection, Active Directory, LDAP Changelog and LDAP 
connectors.

 l Directory LDAP URL: Connection information for the LDAP directory.

 l Security Level: Authentication level to be used. The Identity Bridge help provides full 
details of the available options.

 l User DN: Distinguished name of user.

 l Password: Password for user.

 l Base DN: Distinguished name of search base entry.

Delta Data Store

 l Database JDBC URL:  Connection information for delta database.

 l JDBC Driver Class:  Java driver for required connection. 
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 l User Name:  Valid user login to the delta database. Make sure this user has sufficient 
rights in the database to perform the tasks required.

 l User Password: Valid password for the user.

Flat File 

 l File: Full path for the data file. Alternatively, use Browse to navigate to the data file and 
select it.

 l File Format: Format of the data file. . The online help provides full details of the available 
options.

 l Delimeter: Character or set of characters used as a separator for fields. The default 
delimiter is ‘,’

 l Multi-Value Delimeter: Character or set of characters used as a separator for multiple 
values within the same field. The default multi-value delimiter is ‘|’

 l Read Header Columns:  Indicates that the data file contains field header information.  

LDIF File

 l LDIF File: Full path to the data file. Alternatively, use Browse to navigate to the data file 
and select it.

SQL

 l Database JDBC URL:  Connection information for SQL database.

 l JDBC Driver Class:  Java driver for required connection. 

 l User Name:  Valid user login to the SQL database. Make sure this user has sufficient 
rights in the database to perform the tasks required.

 l User Password: Valid password for the user.

WebAPI (WsSimple)

 l Web Service URL: URL for connecting to the Web Service. Enter the URL Identity 
Bridge should use to make Web API calls.

 l Security Level: Authentication level to use. Choose one of the following:    

 l Username: For UserPassword and UserPassword with SSL, the user name to 
authenticate as.

 l Password: For UserPassword and UserPassword with SSL, the password to 
authenticate with.

 l Headers:  Additional HTTP headers required for the connection.
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Built-in functions
IB Built-In Functions Parameters

$context.appendBinaryFile (filePath, byteArray)

$context.appendTextFile (filePath,  string)

$context.debug (string)

$context.error (string)

$context.executeSQL (resourceName, sql)

$context.executeShellCommandGetBinary (command)

$context.executeShellCommandGetText (command)

$context.fromBase64 (base64String)

$context.fromHex (hexString)

$context.getFailedCountAtTarget ()

$context.getMD5Hash (string)

$context.getSucceededCountAtTarget ()

$context.getWorkspaceDirectoryPath ()

$context.isBase64 (input value)

$context.print (string)

$context.readBinaryFile (filePath)

$context.readTextFile (string)

$context.readHttpURL (httpURL, resourceType)

$context.searchByLDAP*
(resourceName, columnsDefinition*, base, 
scope, filter)

$context.searchBySQL* (resourceName, columnsDefinition*,sql)

$context.sendMail
(host, [port], [userName, Password], 
fromAddress, toAddress, [ccAddress, 
bccAddress], subject, text)

$context.terminateProject ()

$context.terminateTask ()

$context.toBase64 (byteArray)
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$context.toHex (byteArray)

$context.warn (string)

$context.writeBinaryFile (filePath, byteArray)

$context.writeTextFile ()

* Previous versions of Identity Bridge support comma separated lists for the deprecated 
columnNames parameter and do not allow you to specify data types. As a result, these 
functions are not backwards compatible with earlier versions.
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